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WHS MT4 User guide 
This guide will: 

help you to discover the functionalities of 

the WHS MT4. 

explain the basic and most interesting 

features inside WHS MT4. 

 

Detailed information can be found in the 

HELP section inside the platform. 

Getting started with WHS MT4 
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Global overview of the WHS MT4 workspace 

Menu Bar 

Market Watch 

Navigator 

Window 

Terminal 

Window 

Chart 

Window 

Tool Bar 

 WHS MT4 has all features and charts you need to trade directly on start-up. 

.  
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Features of the WHS MT4 workspace 

Menu Bar 

File – Displays menu options for 

opening and printing charts, managing 

chart profiles and displaying account 

information. 

 

View – Contains menu options for displaying WHS 

MT4 windows and toolbars. You can also manage 

your language preferences and access the Strategy 

Tester from this window. 

. 

 Insert – Displays menu options for 

displaying indicators, drawing and 

analytic objects and text in the chart 

window. 

 

Charts – Contains menu options for managing the 

appearance of the chart window. You can change 

the time frame and chart type as well as display grid 

features. 

Tools – Contains tools for placing 

orders, displaying the History Center, 

accessing MetaEditor and customizing 

the interface. 

 

Window–Displays menu options for arranging the 

window in the WHS MT4 workspace. 

 

Help – Contains menu 

options for displaying WHS 

MT4 online help, accessing the 

MQL.4 (the WHS MT4 

programming language) 

community and viewing 

version information. 

managing chart profiles and 

displaying account 

information. 

 

Market Watch 

Navigator 

Window 

Terminal 

Window 

You can monitor your trading activity, manage 

your expert advisors and perform other 

trading tasks in the Terminal window. This 

usually appears at the bottom of the WHS 

MT4 workspace. These features are arranged 

in the window on several tabs.  

Note: If the Terminal window is not displayed, 

you can view it by clicking the View menu and 

selecting the Terminal menu option.  

The Trade tab displays your open positions 

and pending orders. This is where you’ll 

manage all of your trades.  

 

Chart 

Window 

Tool Bar 
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Features of the WHS MT4 workspace 

Menu Bar 

Market Watch 

Navigator 

Window 

Terminal 

Window 

Chart 

Window 

Tool Bar 

Browse easily 

between the 

quoteboard 

and a tickchart 

 You can monitor the real-time bid and ask prices of the available instruments in the Market Watch window.  
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The Symbols tab displays 

a list of instruments to 

trade and their prices. 

 

The arrow beside the 

instrument symbol shows 

if the price is rising or 

falling. The Bid and Ask 

prices will appear in a 

different color. If the price 

is lower than the last 

reported one, the 

numbers appear in red. If 

the price is higher than 

the last reported one, the 

numbers appear in blue. 

 

You can double-click on 

an instrument to view the 

Order window and place 

an order to trade. 

 

 

If you right-

click on an 

instrument 

when the 

Symbols tab 

is selected, 

you can 

access a 

drop-down 

menu with 

several 

options, like 

open a chart 

window or 

place a new 

order… 

 

Select “Symbols’ from the drop-

down menu to choose the symbols 

you want to have inside the 

marketwatch window. Symbols are 

categorized per type. To add them 

to your list, just select the symbol 

with a single left click and then 

press the Show-button on the top-

right corner. Repeat this action for 

all desired symbols. Click on Close 

to finalize. 

 



Features of the WHS MT4 workspace 

Menu Bar 

Market Watch 

Navigator 

Window 

Terminal 

Window 

Chart 

Window 

Tool Bar 

On the Common tab, you 

can select menu options 

from a grouped list. To 

display the available 

menu options, click +next 

to the group name. To 

hide them, click – next to 

the group name. 

 

As you trade, you’ll want to add indicators to chart 

windows as well as activate WHS MT4’s autotrading tools, 

such as expert advisors, custom indicators and scripts. 

The Navigator Window is where you can view all of the 

available tools 

The Navigator window is divided into two tabs.  

. 

If you right-click on a specific indicator,  

expert advisor, script or custom indicator, you can select 

Add to Favorites from the drop-down menu. 

You can then view these on the Favorites tab on the 

Navigator window. 

Switch to the Favorites Tab 

to browse to you Favorite 

indicators, robots, scripts 

etc. 

 

Contains a list of 

available expert advisors 

strategies, these are 

programs that 

automatically analyse 

market conditions and 

place trades based on 

criteria you set. 

Displays a list of trader-

modified technical 

indicators. 

Contains a list of 

available scripts; these 

are programs that 

perform a single 

trading action once. 

Displays the list of open 

accounts. If you have 

more than one account, 

you can switch here. 

Shows a list of up to 100 

different technical 

indicators. 

Note: You can 

download expert 

advisors, custom 

indicators, scripts and 

libraries from other 

sources or create them 

in MetaEditor, an 

application installed with 

WHS MT4 that develops 

autotrading tools 
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Features of the WHS MT4 workspace 

Menu Bar 

Market Watch 

Navigator 

Window 

Terminal 

Window 

Chart 

Window 

Tool Bar 

WHS MT4 groups its most commonly used tools on four toolbars. You can access these by clicking the View menu, selecting 

Toolbars and then clicking on the menu option for the toolbar you want. 

.  

 
The Standard toolbar contains tools to display windows in the workspace 

 The Charts toolbar contains all tools to manipulate the chart window. 

 

 

The Periodicity toolbar displays the charts available time frames  

The Line Studies toolbar contains tools for displaying drawing and analytic objects 

and text in the chart window. 

 
The chart window plots the real-time prices of an instrument on a graph and provides a snapshot of market movements over a 

particular period of time. 

.  

 

Time and 

date 

Price 

There are several ways to open the chart window. One of the most common is to right-click on an instrument in the Market 

Watch window and select Chart Window.  

 You can open more than one chart at a time (up to 99 can be displayed). When the Charts Bar is active, you can switch between 

them by clicking the instrument tab at the bottom of the window. 

 You can customize the chart window using the tools in the Chart toolbar. 

 

Note: If you do not see the tabs on the bottom of your chart, click the View menu and make sure Charts Bar is check marked 
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Using the tools  

 Opening Charts 

 

Right Click an instrument in the 

Market Watch and select chart 

window 

 

 

Drag an instrument from the Market 

Watch window in an existing chart 

window. 

 

 

In the Menu Bar go in ‘File’ or go in 

‘Window’ and open a New chart 

window for the desired instrument. 

 

 

In the Tool Bar click on the button to 

add a chart 
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Using the tools  

 Displaying the tools 

 

 

 

 

Bar Chart displays the price moves of the 

selected instrument as a sequence of 

bars. Each bar displays the high, low, open 

and close of the instrument and 

represents the trading activity for the time 

frame selected in the chart. 

 

 

 

Line Chart displays the price moves of the 

selected instrument as a continuous line. 

The line conects the close prices for the 

time frame selected in the chart. 

 

 

 

Indicators  displays a drop-down menu with indicators. You 

can select between the most commonly used indicators or 

click the folder where the indicators are organized by type. 

When you select one, WHS MT4 opens a window so you can 

specify settings for the indicator and then view it in or below 

the chart. For more information on indicators, see Managing 

Indicators in the Chart Window in this section. 

 

 

 

Period displays the 

selected time frame for 

the chart. You can also 

use this to change the 

time frame of the chart 

from one minute (M1) 

to one hour (H1) to 

daily.  

 

 

 

Templates displays a drop-

down menu for loading and 

saving a chart template. With a 

chart template, you can save 

the chart type, time frame, 

indicators, expert advisors and 

other settings and apply it to 

any chart. 

 

 

 

Chart Shift arranges the chart 

so the latest price moves 

appear at a certain point in the 

chart. When active, you can 

click the triangular marker at 

the top of the chart window and 

set it anywhere between the 

right side of the chart and the 

middle of the chart.  

 

 

 

AutoScroll updates the chart so 

that it always scrolls to the right 

to show the latest price moves. 

 

 

Zoom In magnifies the most 

recent price moves and 

displays them on the chart.  

 

 

Zoom Out decreases the 

magnification of the chart.  

 

 

 

Candlestick Chart tracks the price moves 

of the selected instrument as a sequence 

of blocks or candles. Each candle displays 

the high, low, open and close of the 

instrument and represents the trading 

activity for the chart time frame. With 

candlesticks, you can analyse the market, 

spot trends and forecast their direction. 
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Using the tools  

 Working with charts 

 

You can also zoom in, zoom out, change the time frames, 

display a grid, volumes, save as  picture and print directly 

by a right click in the chart. 

You can quickly switch between charts and time frames or scroll to a particular point in time on the chart using the Fast Navigation 

text box. You can display this field by double-clicking in the lower left corner of the chart. 

Once open, you can enter a specific time, date, symbol or all of these and press Enter on your keyboard.  
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Using the tools  

 Drawing in charts 

 
 

 

 

It enables you to click on other drawing 

objects and drag them to new locations in 

the chart. This is active when you first 

open the chart window. 

 

 

 

It adds a horizontal line on the chart. 

These can be used to plot a horizontal 

support or resistance level. When this is 

selected, click in the chart to place the 

line.  

 

 

 

It plots a diagonal trendline drawn through 

a series of high or low price points in the 

chart window. When this is selected, click 

where you want your line to begin and drag 

your cursor to place the line. You can add 

multiple trendlines to the chart. 

 

 

 

 

It adds a comment to the chart window. As you scroll, the comment remains displayed over the chart. When selected, you can click in the chart window where the 

comment text should be. This opens the Label window with the Common tab displayed. Here, you can enter a name for the comment, add the text you want and 

change the color, size or font. You can also specify the time and the angle of the comment on the Parameters tab or select if the text label should appear on all 

chart time frames on the Visualization tab. 

 

 

 

 

It adds a label to a particular part of the chart. When selected, you can click in the chart window where the label 

should be. This opens the Text window with the Common tab displayed. Here, you can enter a name for the label, 

add the text you want and change the color, size or font. You can also specify where the label should anchor on 

the Parameters tab or select if the text label should appear on all chart time frames on the Visualization tab.  

 

  

 
It turns your cursor into a cross when you move around the chart 

window. When this is selected, you can find out the distance 

between the points and the current price value by clicking on a 

point in the line and dragging to another point.  

 
  

 
It plots two parallel lines that remain equidistant, no matter where 

you place them in the chart window. When this is selected, click 

where you want the channel to begin and drag your cursor to place 

it. You can then click on the secondary line and drag it in the chart. 

  

 
It draws six parallel lines at specific 

distances defined by the Fibonacci 

sequence (0.618, 1.000, 1.618, 2.618, 

4.236). When it is selected, click where 

you want the channel to begin and drag 

your cursor to place it. 

 

  

 

 
It adds a vertical line on the chart. These 

can be used to mark the beginning of a 

trend or specify a time when you entered 

the market. When this is selected, click in 

the chart to place the line. 

 

9 



Using the tools  

 Drawing in charts 

 
It displays a drop-down menu, so you can select from 

eight different types of icons to add to the chart 

window. If you add too many of these icons to the 

window, you select the Delete All Arrows menu option 

to remove all icons from the window. 

 

Note: WHS MT4 draws all trend lines on the charts 

as rays, lines which start at one point and continue 

in one direction toward infinity. You can change this 

using the Objects List 

 

After you add a drawing to the chart, you can change 

its appearance and properties as well as add a label 

to it by right-clicking in the chart window and selecting 

Objects List. This displays the Objects On… window. 

The Objects  On… window shows a list of all objects 

that are currently displayed in the chart window. It 

also contains four command buttons. 

Objects that are checked are currently selected and 

can be edited. 

Show changes the view of the chart window, so the 

currently selected object is prominently displayed. 

 

 

Note: WHS MT4 draws all trend lines on the charts as rays, lines which start at one 

point and continue in one direction toward infinity. You can change this using the 

Objects List 
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Using the tools  

 Grouping charts with Profiles 

 
  

WHS MT4 allows you to open multiple charts and save them in a profile. Many traders use this to compare their most commonly traded 

instruments. You can use the Profiles menu option in the File menu to save multiple groups of charts. 

 

When you click the File menu and select Profiles, you can:  

 

Display one of the existing profiles by selecting its name from the 

drop-down menu that appears. When selected, a check appears 

beside it to show you that it is active.  

Return to the original profile by choosing Default.  

Move between profiles by clicking Next or Previous.  

Save several charts already displayed as a set by clicking Save As… 

Once saved, it appears in the Profiles drop-down menu with a check 

beside it to show you that it is active.  

Delete a profile by clicking Remove and selecting the profile you want 

from the drop-down menu.  

 

When you open a profile, each chart window appears with its settings 

in the same location as it was when it saved.  

Saving a Profile: 

 

1. Click the File menu and select Profiles. 

2. When the drop-down menu appears, select Save As… 

3. In the Save Profile window, you can type in a new name or select an existing name from the drop-down menu to save over that profile. 

4. Click OK. 

Note: If you make a change to the chart windows in a profile, you don’t have to save it. These are automatically saved in the current profile. 

Note: The profiles in the drop-down menu or the Profiles folder on your computer may vary from the graphic that you see here. 

Tip: You can also use these commands by clicking 

 

in the Standard toolbar. This displays a drop-down menu similar to the one that you see when you click the File menu and select Profiles. 

11 



Using the tools  

 Technical indicators  

 
Many traders use technical indicators to forecast where the market may be going. In WHS MT4, you can select up to 30 different technical 

indicators to appear in the chart. There are several ways to add an indicator to a chart: 

 
 

 

Click + next to Indicators in the Navigator window to 

display the list of indicators. Then click and drag the 

indicator to the chart window. 

 

 

Right-click on the indicator you want in the Navigator 

window and select Attach to a Chart 

 

 

 

Click the Insert menu and select Indicators. This 

displays a drop-down menu where the indicators are 

organized in folders by type (Trend, Volumes, 

Oscillator, etc.). You can select the folder and click on 

the indicator in it.  

 

 

 

Click in the Charts toolbar. This displays a drop-down 

menu with a list of the most recently used indicators 

and then the indicator folders. You can select the 

indicator you want or click on the folder and select the 

indicator.  

 

When you add an indicator to the chart, a settings 

window for that indicator appears. You can specify 

settings for the indicator over several tabs. The ones 

that you see depend on the indicator you selected.  

 

When an indicator is attached to the chart, you can 

right-click in the chart window and select Indicators 

List. This opens the Indicators on… window. You can 

use this to view the indicators already attached to the 

chart. When you select an indicator, you can click Edit 

to open the settings window for that indicator or click 

Delete to remove it from the chart. 
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Using the tools  

 Expert advisors 

 
With WHS MT4, you can use automated trading strategies called expert advisors to perform prompt technical analysis of price data 

and manage trading activities based on current market conditions. When an expert advisor is attached to the chart, you can right-

click in the chart window to modify, test and delete it. 

 

For More explanation on 

expert advisors, you can 

click on Help and visit the 

MQL4.community 
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Using the tools  

 Templates 

 
With a chart template, you can save the chart type, time frame, indicators, expert advisors and other settings and apply it to any chart 

WHS MT4 includes a number of already existing templates which you can select by right-clicking in the chart window and selecting Template. From the drop-down 

menu, select one of the listed templates. The chart window updates immediately.  

If you’ve used WHS MT4 before and have template (.tpl) files, you can import these by placing them in the Templates folder on your computer. You can then import 

template files in MT4 using the Load Template… menu option.  

You may notice the default.tpl in the Templates folder. This is a basic template that is created during the WHS MT4 installation and applied automatically whenever 

the chart window is opened. While you can edit this file, you cannot save over it.  

You can save the contents of the chart window as a template or save 

changes you’ve made to an existing template by using the Save 

Template… menu option. Once saved, the template appears by name in 

the list of templates. 
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Trading  

 Pricing and contract information 

 
Before you place an order, you’ll want to monitor the price and determine a good point to enter the market. You’ll also want to pick 

points for your take profit or stop loss orders. You can monitor prices and view contract information in the Market Watch window.  

 

You can monitor 

the real-time bid 

and ask prices of 

the available 

instruments in 

the Market Watch 

window.  

 

In addition to the 

Market Watch 

window, you can 

also view the 

Popup Prices 

window. Like the 

Market Watch 

window, this 

displays a list of 

symbols and 

prices. You can 

view this by right-

clicking in the 

Market Window 

and selecting 

Popup Prices. 

 

Before you trade, you may want to see the spread, margin, contract 

size and other details about the instrument you are interested in 

trading. You can view contract information by right-clicking in the 

Market Watch window and selecting Symbols. When the Symbols 

window appears, select the instrument you want and click Properties. 

This opens the Contract Specification window for the instrument you 

selected. 
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Trading  

 The order window 

 In WHS MT4, you’ll place most of your manual orders using the Order window. There are several ways to open the Order window: 

Select New Order from the tools menu. 

Click    in the Standard toolbar.  

Make Right-click on a position in the Terminal 

window and select New Order from the drop-

down menu. 

Chart – View the current by-tick price 

movements of the instrument. The blue line 

represents the current ask price and the red 

shows the current bid price.  

Symbol – Select an 

instrument to 

trade.  

Volume – Specify the 

number of lots you want 

to trade.  

Type – Choose whether 

your order is a market 

order or a pending order.  

The Order window 

displays some of the 

same fields as it does 

when you enter a market 

order. When you select 

Pending Order from the 

Type menu, a new 

section, Pending Order, 

appears. You can select 

what kind of pending 

order you want, the price 

and the expiration date of 

the trade.  

If you are using a pending 

order to enter the market, 

you can enter a specific 

price in the At Price text 

box. 

You can specify how long you want your pending order to be available by using the Expiry checkbox. After you click the checkbox, you can select a specific expiration date and 

time.  

  

Selecting Pending Order also opens the Stop Loss and Take Profit text boxes. If desired, you can set the prices you want for these orders.  

  

If you place a stop loss or take profit order, the chart in the Order window displays a line representing these pending orders.  

If you enter an inappropriate price for either the Stop Loss or Take Profit text boxes and click Place to enter your order, WHS MT4 displays a notification message. If you are 

entering both types of pending orders, WHS MT4 lets you know if the stop loss (SL) or take profit (TP) is wrong. Click OK and then adjust the price.  

Once your order becomes 

a position, you can view it 

on the Trade tab in the 

Terminal window. If you 

didn’t specify a stop-loss 

or take-profit order when 

you first placed your 

order, you can add those 

orders by right-clicking in 

a position row and 

selecting Modify or Delete 

Order to open the Order 

window.  

By the same way(Right 

Click  on the pending 

order )you can modify or 

delete a pending order. 
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Trading  

 Managing orders & Viewing account history 

 
Once you place a trade, you’ll want to view your open positions and pending orders as well as your closed trades. You can do so on two 

tabs in the Terminal window.  

 

You can manage all of your open positions and pending orders in the Trade tab of the Terminal window. You can also view your balance, equity and margin data in this tab.  

  

When you right-click in a position row, you can select menu options to open an order, modify or delete an order or close an order.  

  

You can also right-click in the tab and select menu options to add the Commissions, Taxes and Comments columns to the table. You can also choose to display the value in the 

Profit column in points, term currency or deposit currency. 

 

You can view all of your executed trades on the Account History tab of the Terminal window. Here, you can also view your profit and loss, 

credits, deposits and withdrawal information. 

.  

 

When you right-click in a position row, you can select menu options to filter and sort the orders that appear in the tab by the last three months, last month, or a custom period. If 

you sort the orders, you can also click All History to view all orders again.  

When you select Custom Period, you can use the From and To drop-down menus to select specific dates.  

On both tabs, you can also change the appearance of the table by selecting Auto Arrange, which resizes the columns automatically if the Terminal window size changes, or Grid, 

which displays the lines between the rows and columns.  

 
Note: With live accounts, it is recommended that you view your account history in both WHS MT4 and the web application. The transactions and values you see in the web 

application are the most accurate and legally-binding. You should rely on these values when you are trading. If you have questions about the difference between the two platforms, 

contact our customer service. 
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In Consideration of WH SelfInvest licensing MetaTrader4 software to the customer, the customer agrees and acknowledges as follows: 

  
1. WH SelfInvest grants to customer a limited, non-exclusive, non-transferable license to use the MT4 Software for personal trading only. This license does not convey to 

Customer any interest in or to the Software, but only a limited right of use revocable by the terms of this Agreement. The Software shall be utilized by Customer only in 

accordance with this Agreement and shall not be de-compiled, reverse engineered, incorporated into any other software (including any source code, object code or 

algorithms), modified or disclosed in any form by any media to any other person or party. 

  

2. Customer represents and warrants that Customer is not a broker, and will not use the Software for trading by an institution. 

  

3. Customer will be responsible for maintaining all equipment used by Customer in connection with the Software, and for obtaining and paying for a subscription to any 

data feed that is necessary in order to use the Software. 

  

4. WH SelfInvest shall not be liable for, and Customer agrees not to hold or seek to hold WH SelfInvest or its officers, directors, employees or agents liable for, any 

technical problems, system failures and malfunctions, communication line failures, equipment or software failures and malfunctions, and other similar computer problems 

or defects. The Software is provided "as is," and WH SelfInvest does not make any warranties or guarantees with respect to the Software, including without limitation, 

warranties of merchantability or fitness for a particular purpose. WH SelfInvest shall not be liable to Customer for any loss, cost, damage or other injury, whether in 

contract or tort arising out of or caused in whole or in part by Customer's use of or reliance on the Software or its content. In no event will WH SelfInvest be liable to 

Customer for any punitive, consequential, special or similar damages even if advised of the possibility of such damage. If some jurisdictions do not allow the exclusion or 

limitation of liability for certain damages, in such jurisdictions, the liability of Dealer shall be limited in accordance with this Agreement to the extent permitted by law. 

 

5. Customer understands and acknowledges (a) that the Software may include trading systems developed by WH SelfInvest and trading systems developed by third 

parties over whom WH SelfInvest has no control and for whom WH SelfInvest is not responsible, and (b) that all orders for trades placed pursuant to indicators generated 

by the Software are for Customer's sole risk. Customer understands and acknowledges that there is substantial risk in trading foreign currencies and other financial 

instruments with or without the Software, and that past results are not necessarily indicative of future results. 

 

6. WH SelfInvest makes no representations concerning the performance of any trading systems included in the Software or the suitability of the Software for use by 

Customer. The provision of Software by the WH SelfInvest is for informational purposes and does not constitute an advice or recommendation. The Software does not 

take into account any particular individual's investment objectives, financial situation or needs, and should not be relied upon as a substitute for extensive research. 

Customer should obtain advice based on their unique situation before making any investment decision based upon any information contained within. 

 

7. Customer will hold harmless and indemnify WH SelfInvest, and its licensors, officers, directors, employees and agents, from and against any and all losses, costs, 

damages and liabilities, including reasonable attorneys' fees, resulting directly or indirectly from the use of the Software by Customer or Customer's agents, including any 

claims brought against WH SelfInvest that arise out of or relate to the use of the Software by Customer or Customer's agents. 

 

 

 



  

 

 
 

8. Any complaint, claim or dispute arising out of or relating to this Agreement shall be litigated only in courts located in the jurisdiction identified below, and Customer 

hereby consents to the personal jurisdiction of such courts for such proceedings. 

  

9. Without the prior written consent of WH SelfInvest, Customer may not assign, sub-license, transfer, pledge, lease, rent or share Customer's rights, duties or obligations 

under this Agreement to or with any person or entity, in whole or in part. This Agreement shall be binding upon and inure to the benefit of the respective parties, their legal 

representatives, successors and permitted assigns. 

  

10. Customer understands that termination must be in writing, and may be sent by e-mail or by fax to the email address or fax number identified below. Customer 

understands that oral termination will not be accepted. 

 

11. WH SelfInvest may terminate this Agreement upon a material breach by Customer that is not cured after ten days' written notice to Customer. WH SelfInvest may also 

terminate this Agreement upon written notice to Customer if WH SelfInvest or its licensors determines that they will no longer offer the Software to WH SelfInvest's 

customers. 

  

12. Customer understands that the Software will send orders directly to WH SelfInvest for execution for Customer's account and risk. Customer assumes full liability for all 

trades made as a result of WH SelfInvest's execution of such orders. 

  

13. Customer understands that Customer may make transactions in Customer's account independently of a Third Party System, and that Customer may terminate the 

Third Party System's ability to generate orders at any time by disabling the Third Party System. 

  

14. Customer acknowledges and understands that the following differences will exist between the data and output on the Software as compared to the data and output on 

the Dealer's trading platform ("the Trading Platform"): 

  
The equity value of Customer's account as shown on the Software may vary from the equity value as shown on the Trading Platform. The equity value shown on the 

Trading Platform is the correct value, and is the value Customer should rely upon when trading. The Dealer has an account reconciliation tool which will periodically 

reconcile the two values, but Customer should rely only on the value shown on the Trading Platform. 

 

Clients will only be able to place orders via telephone in case of emergency. The only orders which are accepted are those to close existing 

positions and no orders for the purpose of opening new positions can be placed. Orders which are placed via telephone will not be reflected in 

your platform immediately since these need to be externally filled. This could cause positions to be showing incorrectly in the platform for 

some time prior to being updated. 

 

 

 

 


